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Abstract— The paper will give an example of project 
learning in the subject Computer Graphics and Multimedia, 
which is performed in the study program Business Informat-
ics and Programming, in basic vocational studies. The aim 
of the course is to understand the role of computer graph-
ics and multimedia in modern business and communication 
and to master the basic techniques of creating graphic and 
multimedia content. For the needs of the proposed project 
learning, students should first get acquainted with the theo-
retical foundations of creating raster documents: techniques 
of processing raster objects (tool palette, layering, selection, 
transformation, coloring, lighting, filters, actions, text in-
put and editing…), creating content for the Web, preparing 
for printing and publishing. The proposed example will be 
implemented through the following phases: selection of the 
topic - defining the problem to be worked on, project prepa-
ration and work plan development, project flow, presentation 
of project results and evaluation. The focus is on recording, 
analyzing and processing images on a given topic. It is expect-
ed that it will give an example of project learning that can be 
implemented in primary vocational education as a method 
for educating students in Computer Graphics and Multime-
dia, that students will achieve better exam results and that 
this method of work will be gladly accepted by students.

Keywords— project-based learning, higher education, 
computer graphics and multimedia, raster object processing

I.	 INTRODUCTION

Continuous improvement and improvement of the 
knowledge transfer process aims at more efficient produc-
tion of professionals who will be able to respond to the fu-
ture challenges of their profession, and to take responsibil-
ity for their decisions [1]. In modern didactics, the largest 
number of criticisms refers to frontal work which is aimed 
at satisfying the needs of only average students. This way 
of working is based on the transfer of ready-made knowl-
edge where students are passive participants. In order to 
overcome these problems, it is necessary to modernize the 
teaching process by developing and using new methods of 
work [2] that would put students in the forefront as active 
participants in the learning process. One such form of ac-
tive learning is project-based learning [2]. 

II.	 REVIEW OF LITERATURE

Project-Based Learning is a comprehensive approach to 
teaching and learning in the classroom designed to involve 
students in research on authentic issues [3]. It is a form of 
learning that trains students in real-world challenges they 
may face in future professional career [4]. Project-based 
learning enables students to learn by working and applying 
their ideas, to deal with real, meaningful problems that are 
similar to the activities of adult professionals [5]. Through 
this type of learning, students are given the opportunity to 
research, ask questions, suggest hypotheses and explana-
tions, discuss their ideas, challenge the ideas of others and 
try new ideas. Research has shown that students who learn 
teaching content organized through meaningful problems, 
show better results than students who study in the tradi-
tional way [6, 7, 8]. Project-based learning has long been 
used in higher education as a method for educating stu-
dents with the help of realistic problem tasks [9, 10]. These 
tasks usually require initiative and independence from the 
student. They need a lot of time to complete, result in the 
production of the final product (eg reports or presentations) 
and use educators in an advisory role [3,11,12]. Projects 
can often involve students working in groups with the aim 
of encouraging collaboration and developing interpersonal 
competencies. This approach has already been implement-
ed as a good practice in bioinformatics training [13]. PBL 
- Project Based Learning allows students to learn organ-
ized in groups in which they work together to solve spe-
cific problems and finally present the final result of their 
work-projects in the form of a multimedia presentation, 
written report, website or constructed product [2].

Project-based learning (PBL) is an active form of stu-
dent-centered learning. It is characterized by student au-
tonomy, constructive research, goal setting, cooperation, 
communication and reflection in real world practice. Re-
search conducted in different contexts at different stages 
of schooling, from primary to higher education, could not 
determine with certainty the causal link between PBL and 
the positive results of both students [14].

Experiential learning is a key factor in acquiring 
knowledge through experiencing things. The basic idea 
of project-based learning is to connect students' experi-
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ences with school life and to provoke serious thinking as 
students acquire new knowledge. Through experiential 
learning, and especially through PBL, a connection with 
real-world problems is made [15].

In his paper, Dimmitt [16] analyzes the extent to which 
project-based learning (PBL) contributes to learning effi-
ciency and the extent to which it provokes critical think-
ing among first-year university students. The results of his 
analysis showed that the PBL method can learn students 
effective techniques for increasing self-confidence and in-
dependent, critical thinking that are necessary for students 
to be successful in their academic endeavors. Sulaiman and 
colleagues [17] investigated the effectiveness of involving 
students in environmental projects. The results of the re-
search showed that the greatest impact on the students had 
projects that required them to make pleasant and unusual 
final products such as a documentary, a campaign through-
out the school and an environmental exhibition throughout 
the school. This result indicates that PBL can be imple-
mented with few resources, within the school building and 
in the time allotted for processing the topic.

Branch [18] conducted a study to determine the ef-
fects of project-based learning on student achievement in 
mathematics. The study examined differences in student 
achievement in two charter schools in Chicago. In one 
school, the traditional way of learning was applied, and 
in the other, project-based learning. The results revealed 
that there are statistically significant differences in stu-
dent achievement between schools that used project-based 
learning as a learning approach and schools that used a 
traditional learning approach.

The interdisciplinary field of mechatronics encompass-
es a coherent interactive design process that facilitates, in-
novates and develops desired skills by adopting experien-
tial approaches to learning. Mechatronic educational and 
experimental systems have been developed to facilitate ex-
periential learning and improve the learning process in or-
der to stimulate thinking skills in undergraduate students. 
Developed educational and experimental systems of Me-
chatronics are designed, implemented, programmed, tested 
and successfully used by students within the designed lab-
oratory. Developed systems have their own learning indi-
cators where students acquire knowledge and learn certain 
skills. Knowledge is acquired through engagement, prac-
tical experience focused on students inspired by collabo-
rative participation, reflection and interactive discussion. 
The integration of learning outcomes related to the devel-
oped educational and experimental systems of Mechatron-
ics, combined with the project-based learning approach, 
has given the desired results that indicate the improvement 
of the learning process. The effectiveness of the developed 
experimental systems has been demonstrated through an 
experimental laboratory and through project-based learn-
ing at Sanio_Onoda City University, Yamaguchi, Japan, 
and the American University in Cairo [19].

Numerous studies have investigated the effectiveness 
of learning based on examining the effectiveness of the 

application of the PBL method in the education of engi-
neers in various countries. For example, Ruikar and Dem-
ian [20] found that there was a link between learning suc-
cess and engaging industry partners through multimedia 
podcasting in the UK. Industry partners provide real-world 
cases that put them in the context of theoretical content.). 
Multimedia content podcasting also addresses the issue of 
student engagement. They can adapt to different ways in 
which students learn (eg VARK - video, audio, reading / 
writing and kinesthetic sensory learning modalities). The 
paper describes a case study of the application of pod-
casting in the final year design module at Loughborough 
University. The students were assigned a master planning 
project on which to work. An industry partner was hired to 
record an audio-visual session in which he gave a report 
on key design considerations and rationale for the master 
planning project. Later, in a dedicated lecture module, an 
audio-visual podcast was released. Students were briefly 
introduced to the scope of the podcast's content. The sur-
vey found that the student showed very good results on 
the test and gave a very high grade to the podcast in the 
questionnaire that asked for their subjective reaction to the 
experience. 

Hassan et al. [21] have adopted an integrated, multi-
disciplinary, project-based learning methodology in e-en-
gineering in Spain. Fernandes et al. [22] also applied a 
project-driven education model developed by Powell and 
Weenk (2003), and applied it as a learning model to stu-
dents at the University of Portugal. 

Another study looked at project-based language learn-
ing. They used the theory of activities in the university 
language program in Ireland. This study showed mixed 
results in learning outcomes for study participants. Such 
results are a consequence of contradictions identified in 
the system of activities (unequal division of labor, lack of 
time due to community obligations or opposition to the 
rules governing activity in modules). [23].

III.	 EXAMPLE OF PROJECT LEARNING  ON THE 
SUBJECT OF COMPUTER GRAPHICS AND 

MULTIMEDIA 

Basic information about the project: Project learn-
ing is extremely suitable for learning in the IT group of 
subjects through which, in addition to theoretical knowl-
edge, some organizational skills are acquired, communi-
cation skills, creativity, ability to take responsibility and 
ability to work in a team. From the group of informatics 
subjects that are studied at the basic vocational studies is 
the subject Computer Graphics and Multimedia. From the 
curriculum of the subject Computer Graphics and Multi-
media, a certain unit has been singled out, which refers to 
the processing of photography. Through lectures in high-
er education, on the processing of photography, teachers 
convey important theoretical information. Exercise classes 
work on the practical improvement of theoretical knowl-
edge by applying creative methods of work on selected 
content. Learning can be organized as a project research 
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task. Students are engaged in processing the photo so that 
it is convincing enough for the observer. Editing and pro-
cessing a photo can be extremely interesting because its 
quality can be improved, and even top quality photos can 
be obtained. The project would be organized over three 
weeks (6 school hours). Students are divided into groups 
of 5. The groups are heterogeneous. Each group has a full 
task.

A. Preparatory phase

Project topic: Creating raster documents: techniques 
of processing raster objects (tool palette, layering, selec-
tion, transformation, coloring, lighting, filters, actions, text 
input and editing…).

Project objectives: General objective: to understand 
the roles of computer graphics and multimedia in modern 
business and communication and to master the basic tech-
niques of creating graphic and multimedia content.

Specific objectives: to improve the levels of informa-
tion literacy by collecting and selecting information; to 
develop and improve communication skills; to develop 
more efficient and effective collaborations-cooperation 
of an individual in a group in order to achieve a common 
goal; to form critical thinking (ability to distance oneself 
from one's own beliefs and prejudices in order to come to 
well-founded and logical conclusions about what to be-
lieve and what to do); to develop ICT skills needed to work 
with computer and communication devices, software, ap-
plications ...; to establish cooperation between the two 
Academies of Vocational Studies in Sabac and Valjevo.

Project outcomes: Students' ability to: organize and 
see the project (acquire the ability to learn, research and 
search, select and use information, develop social skills, 
collaborate, acquire practical and managerial skills ...); 
self-creation of posters, flyers, brochures or similar graph-
ic solutions; self-creation of a logo or illustration on a giv-
en topic; taking and processing a photo on a given topic / 
need.

Holders of activities: Students, teacher. A cooperative 
relationship is formed between them to solve the problem. 
This attitude contributes to the development of self-initia-
tive, greater freedom in work and encourages the responsi-
bility of students to take the initiative in finding solutions.  

Methods of work: Individual and group method, 
Method of oral presentation (description, explanation, re-
porting), Method of conversation (discussion, brainstorm-
ing), Method of reading and working on the text, Method 
of writing, Active and interactive methods of work (Activ-
ity encouraged by teaching technique, content or teacher 
instructions, Interactive methods have the task to transfer 
the activity from teacher to student, to help students learn 
together, solve tasks and evaluate work.).

Forms of work: Team work (projects) - Working in a 
team motivates the student better than working in a group. 

There must be a willingness, knowledge and ability among 
the members of the group to make a full contribution to the 
achievement of a common goal according to their abili-
ties and role. Group form of work: The composition of the 
group is determined by agreement between teachers and 
students. According to the tasks, all groups do the same 
task. 

B. Project planning

Explanation of the project topic: An image is an arti-
fact that displays or records visual perception [24]. An im-
age can be defined as a two-dimensional function f (x, y) 
where x and y are spatial coordinates, and the value of the 
function represents the intensity at a certain point in space. 
Given that about 90-95% of the information about the 
world around us is obtained through the visual system as 
visual effects, quality images must be convincing enough 
to leave a good impression on the viewer. Regardless of 
how the photo was created and whether it is product of an 
amateur or a professional, for high quality, it sometimes 
needs to be subjected to beautification - digital processing 
with the help of digital computers. Digital processing is 
performed to improve the visual characteristics of the im-
age in order to achieve a satisfactory image perception by 
the observer. 

The Chinese proverb "A picture is worth a thousand 
words" confirms that our mind prefers to work with visual 
elements than to use words. We can describe reality in 
words, but we can directly show reality in pictures. And if 
we prefer to use visual thinking as an important aspect of 
information processing, unfortunately, in the field of edu-
cation, graphic methods are mostly neglected and knowl-
edge transfer is most often done verbally. In the middle 
of the last century, a new concept of "visual thinking" 
emerged as a pedagogical approach that advocates the 
view that the ideal way to create, share, develop and ma-
nipulate ideas is to present in a visual sense. We process 
images much faster than any information in text or oral 
form. Visual information leaves a deeper impression on 
us than what we read or what they tell us. It is clear that 
language, as written, so is the oral, very sophisticated and 
useful means of conveying ideas, however, this means of 
conveying concepts has no immediacy or closeness to the 
image. Example: it is much easier to learn what an apple is 
if seen in a photograph or in real life than if we remember 
its definitions [25]. 

Preparation for the selected topic: Students and the 
teacher jointly define the main topic and plan activities and 
contents, evaluate the learning process and their results, 
generate and choose possible options. All team members 
should be equally engaged. Members agree with each oth-
er. Upon completion, each team prepares a report on the 
results of the project. 

Each team was given the same task, to download an 
image from the Internet and approach the development of 
an image processing plan with a specific tool. 
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The teacher suggests tools that I can use: Adobe Photo-
shop and Adobe Lightroom. Adobe Photoshop is selected. 

Reason for choice: Adobe Photoshop (Photoshop) is 
the market leader among professional programs in the field 
of digital image processing and creation [26].

Choice of information sources: scripts from lectures 
and exercises, PowerPoint presentations, materials from 
the Internet, tutorials.

Choice of required resources: Computer, Software 
and image processing application. Instructions-tutorials 
available on Youtube can be used to use some tools. Take 
into account what was presented in the theoretical classes. 
Focus on the levels and phases of digital image processing. 

IV.	 PROJECT IMPLEMENTATION

 Implementation and materialization of ideas. Monitor-
ing the work plan, documenting the implementation of the 
project (notes, pictures...). Possible example of concretiza-
tion of the project topic - opening the project.

A. Task 1: Turn a photo into a drawing. 

 

Fig. 1. Example of concretization of a project topic 
(Initial photo) [17]

Step 1: Launch Photoshop and upload the import photo 
via the “Open” option.

Step 2: To get a black and white drawing, remove the 
color from the photo. Menu bar- find the Image > Adjust-
ments > Desaturate option. Now color of the photo be-
comes "black and white".

Step 3: Duplicate a layer of "black and white" pho-
to. The Layers palette shows all the layers of the photo 
stacked on top of each other. Right-click, select the layer 
and select the Duplicate Layer option in the context menu 
and then select the OK option. A new layer appears on the 
palette above the "Background layer” called "Background 
copy".

Step 4: Convert the "Background copy" layer to pho-
tonegative. Select it if it is not selected (the active layer is 
colored blue) and use the Image > Adjustments > Invert 
option.

Step 5: Work on the layer continues - return to the 
layers and mix colors. Use one of Mod's merges on the 
Layers palette to mix the colors of two photos. Select the 
Color Dodge option from the drop-down menu. Turn the 
white surface into a drawing using a Gaussian Blur filter. 
The Gaussian Blur filter is located on the menu line Fil-
ter> Blur> Gaussian Blur. Select Gaussian blur and make 
adjustments (value ranges between 1 and 10 pixels), 10 
pixels were used for work purposes.

Step 6: You need to “glue” the layers by selecting the 
"Background copy" layer, and right-click to select the 
Merge Visible option. Only one layer is visible on the Lay-
ers palette now. Then the photo editing was successfully 
completed.

Step 7: After converting the photo into a drawing, add 
the text to the photo. Select The Horizontal Type Tool. Use 
font settings (Brush Script MT, Italic) and font size (57 
pt,strong) to add text.

 

Fig. 2. Example of concretization of the project topic 
(Final photo after editing)

B. Task 2: Photo retouching. In Adobe Photo-
shop, retouch the original photo. Remove irreg-
ularities and make corrections on the skin and 
face and make a uniform tonality

 

Fig. 3. Example of concretization of a project topic 
(Initial photo) [18]

Step 1: Open the original photo and duplicate that layer 
(Layer > Duplicate Layer).

Step 2: Select the Spot Healing Brush Tool from the 
Toolbox. By applying this tool, irregularities on the skin 
are eliminated.
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Step 3: Select the copy of layer and again make a du-
plicate of it (Layer > Duplicate Layer), and then apply the 
"Dust & Scratches" filter (Filter > Noise > Dust & Scratch-
es) to that layer.

Step 4: On the same layer, apply a "Gaussian Blur" 
filter (Filter > Blur > Gaussian Blur) with a radius of 2 px, 
in order to obtain a soft skin tone.

Step 5: To get a more natural look, add a "Noise" filter 
(Filter > Noise > Add Noise).

Step 6: Add a mask to this layer via the icon on the 
Layers palette. Fill the mask layer with black (keyboard 
shortcut D, X then ALT + DELETE). Then invert the color 
of the foreground and the background so that the color of 
the foreground becomes white (X on the keyboard), select 
the paint brush (B) and use the brush to "paint the skin" in 
the necessary places.

 

Fig. 4. Example of concretization of the project topic 
(Final photo after retouching)

V.	 PROJECT PRESENTATION

Presentation in Word and PowerPoint presentation 
with a description of the work process supported by pho-
tographs documenting each step. Various tutorials contain 
instructions for making presentations. The presentation of 
the project results is done in front of the teacher for 10 
minutes. If necessary, the presentation time can be extend-
ed, but not longer than 20 minutes, because a longer pres-
entation reduces the attention of the listeners. The ques-
tions are short and are asked at the end of the presentation. 
Question time - no longer than 15 min.

VI.	 EVALUATION

Since the presentation of project results is done in 
front of the teacher, it can be more extensive in the form 
of conversations between teachers and students and based 
on feedback, an assessment can be given. The survey tech-
nique was chosen in this project. The project implemen-
tation is being evaluated. Students should give their opin-
ion in order to find out their position on the implemented 
project. The example of the questionnaire for students is 
arranged according to the survey, ie. Evaluation sheet for 
students [29] with certain modifications:

1. Do you like the way you work on the project?

YES - NO - PARTIALLY - I DON'T KNOW

2. Are you satisfied with the team way of working on 
the project?

YES - NO - PARTIALLY - I DON'T KNOW

3. Are you satisfied with the working conditions on the 
project?

YES - NO - PARTIALLY - I DON'T KNOW

4. Are you satisfied with the coordination of teachers' 
work on the project?

YES - NO - PARTIALLY - I DON'T KNOW

5. Do you better understand the essence of the content 
through classroom lectures or project teaching?

YES - NO - PARTIALLY - I DON'T KNOW

6. Would you prefer team work, project teaching and 
research tasks to be more represented in regular classes?

YES - NO - PARTIALLY - I DON'T KNOW

In addition to the evaluation of the project, future re-
search may also evaluate the work of teachers, the work of 
group leaders and the work of each student individually, 
the evaluation of available literature and the evaluation of 
evaluation. In addition to evaluation in further research, 
the effects of the application of project-based learning in 
higher education can be examined.

VII.	CONCLUSION

The subject Computer Graphics and Multimedia is a 
subject that is taken at the basic vocational studies of the 
first degree. The set goal of the course implies that students 
at the end of the learning process should understand the 
role of computer graphics and multimedia in modern busi-
ness and communication and master the basic techniques 
of creating graphic and multimedia content. The compe-
tencies that are provided in the Curriculum of the course 
are expressed through the outcomes of the course and must 
be in accordance with the requirements of the profession. 
Through the envisaged competencies in this subject, which 
represent knowledge and skills, students should be trained 
for a job in the profession for which they are studying. Re-
search has shown that project-based learning significantly 
contributes to better student outcomes and performance. 
Project learning can be designed and implemented in most 
subjects. The main disadvantage of such learning is the 
limited time frame for the material, which is extensive. 
This kind of learning requires more times than classical 
learning [30]. Excessive material and a condensed sched-
ule burden students. Because they may be uninterested in 
work that additionally burdens them and takes away their 
free time. The problem can also arise because students 
have different places of residence, so there is a problem 
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of organizing meetings outside of school. The advantage 
of the method is that real life contexts and high technolo-
gy tools can be introduced into subject curricula through 
project learning. In this way, students are encouraged to 
work independently, develop critical thinking and lifelong 
learning skills.

The proposed example of project learning could be im-
plemented in learning in which students and the teacher 
would try to organize learning so that the set task is done 
together in order to reach the set goal. For successful im-
plementation of such learning, not only certain experience 
is needed, but also good organizational skills of teachers, 
but also the will to step out of the beaten path of classical 
learning, to accept the challenge and to be more engaged 
in creating higher levels of student education. It is expect-
ed that he will give an example of project learning that 
can be implemented in primary vocational education as a 
method for educating students in Computer Graphics and 
Multimedia, that students will achieve better exam results 
and that this method of work will be gladly accepted by 
students.

According to the Australian College of Teachers' Code 
of Ethics: "Teachers have an obligation to keep pace with 
learning achievements and with theories and strategies of 
teaching... They are responsible for what they teach and 
for the way they build relationships with students" (F. 
Haynes).
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